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Chapter 1: Introduction to Utilities

Toon Boom provides utilities that you can use in a Command Prompt and Shell to providemore flexibility and control
over the different command options in Toon Boom Harmony.

Running a Utility 5

Running a Utility
Toon Boom includes a number of command line utilities that you can use to convert image formats, bitmap or vector,
into other image formats.

These command line utilities are found in your Toon Boom application folder.

l Windows: \Program Files(x86)\Toon Boom Animation\Toon Boom Harmony 14.0 [edition]\win[x]\bin

l Mac OS X: /Applications/Toon Boom Harmony 14.0 [edition]/tba/macosx/bin

l Linux: /usr/local/ToonBoomAnimation/harmony_14/lnx86_64/bin

To run these utilities, use a Command Prompt or Terminal window. All of these utilities work on input files that are
processed using options you specify to produce an output.

How to run a command line utility

1. Open a Command Prompt (Windows) or Terminal (Mac OS X) window or a Console (Linux) window.

‣ Windows: From the Start menu, select Programs > Accessories > Command Prompt.

‣ Linux: Select Menu > System Tools > Terminal.

‣ Mac OS X: Open a Finder window and select Applications > Utilities > Terminal
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2. In the Command Prompt or Terminal window, switch to the directory that contains the image files you
want to process (elements folder).

3. Type the name of the utility you want to launch, and the options and name of the file you want to process.
The options must be preceded by a dash (-).

Here is an example of how to launch utransform usingWindows:

‣ utransform -outformat TGA bg-1.tvg

Here is an example of how to launch utransform usingMac OS X:

‣ utransform -outformat TGA bg-1.tvg

NOTE: If another version of Toon Boom Harmony is still installed on the system, start the utility application
from the \bin folder. This will ensure that the correct version of the utility is used.

‣ Windows: \Program Files\Toon Boom Harmony 14.0
[edition]\nt\bin>./utransform -outformat

‣ Mac OS X: Applications/Toon Boom Harmony 14.0
[edition]/tba/macosx/bin>./utransform -outformat

‣ Linux: /usr/local/ToonBoomAnimation/harmony_14/lnx86/bin>./utransform -
outformat

4. For help with the options and syntax of the utilities, open the help. To do this, type -help after the name of
the utility on the command line.

‣ Type: utransform -help
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Chapter 2: Utilities
This chapter describes all of the utilities, options and their uses.
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Syntax 37

Examples 38
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Pdfimport Utility
The Pdfimport utility is used to import a .PDF or an .AI file as a template without going through the interface. It
allows more control and option flexibility over the imported file.

Here is the format youmust follow when using Pdfimport:

Pdfimport [options] pdf or ai files

The available Pdfimport options are:

Command Action

-outdir output_folder
This option defines the folder where the output files will be
saved. The defined path is not relative.

-outtemplate output_folder.tpl
This option defines the template name for the converted
pages. The defined path can be relative.

-PDF_SUPPORT_CMYK
This option will automatically convert CMYK colours to
RGB. Otherwise, CMYK colours would import as a red
colour.

-PDF_SEPARATE_LAYERS
This option will use the Illustrator top level groups as
separate drawing names.

-PDF_FLATTEN
Use this option to perform a flatten on each drawings while
importing.

Description of Switches

-outtemplate output_folder.tpl Output template name for converted pages.

-outdir dir
This option defines the output folder for the templates (the
defined folder must already exists.)
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-usage This option will display the usage.

-?|-h|-help|--help This option will display the help information.

-v|-version|--version n This option will display the version information.

NOTE:
• The -outdir and -outtemplate options are exclusive; they cannot be used together.

• You can only specify one file with the outtemplate option.

• If the CMYK colours option is not enabled, the application will output the following error message:
CMYK: Unsupported colorSpace

• Pdfimport does not overwrite existing templates, but will overwrite files in outdir.

Pix2vec Utility
The Pix2vec program converts bitmap files, which can be generated during the scanning process, to Toonboom
Vector Graphic (TVG) files. TVG is the vector file format for Toon Boom professional software.

You can vectorize SCAN and other bitmap files by running Pix2vec from the command line. There are a number
of options you can use. To see a list of the vectorization options, type pix2vec --help or pix2vec -? .

Here is the format youmust follow when using Pix2vec:

$ Pix2vec -file [file name, including extension] [options]

Here are the available Pix2vec options:

COMMAND ACTION

FILE IOOPTIONS

-file <filename (including extension)> [options ]
Use this option to define the file you want to
perform Pix2vec on.

-infile <filename (including extension)>

This option is the same as -file.

Use this option to define the file you want to
perform Pix2vec on.

-outfile <filename> Use this option to rename the output file.

-informat <format>
This option defines the input format. Used if
reading from standard input.

-debug Use this option to turn on the debugmode.

-version This option will display the version information.

-output_version [version]
This option defines the output files of this
version. Valid versions can be: 0 or 604. The
TVG format version is 604.

-noforce
This option will prevent the output image from
being forced if the image is inconsistent.

REGISTRATION OPTIONS
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COMMAND ACTION

-register

Use this option to perform optical registration.
Follow this format:

<dpi side strictness>;

The Side position can be left, right, top, bottom or
l, r, t, b.

The Strictness can be either loose, strict or l, s.

-registration_looseness_factor <factor>

Registration looseness factor (by default the
looseness factor is 2.0). This is used for optical
registration only and is calculated
mathematically by the system.

-rlf
This option is the short hand equivalent of the
registration_looseness_factor function.

-rdebug This option output registration debugmessages

-pegpitch <inch (default 8.000000)>
Use this option to customize the value of the
distance between the registrationmarks.

-threshr < (default 0.500000)>

Use this option to set the threshold value for
optical registration.

You can set the value in the range of 0.0 to 1.0.

-rmargin <inch (default 1)>
Use this option to define the size of the region
where registrationmarks can be detected.

-peg_distance_from_center <inch (default 5.25)>
Use this option to determine the distance
between the centre of your page to the peg
registrationmarks.

-pdfc

This function is the short equivalent of peg_
distance_from_centre.

Use this option to determine the distance
between the centre of your page to the peg
registrationmarks.

-out_peg_position <side (default same)>

This option defines the wanted position of the
peg on the drawing.

The position can be right, left, top, bottom, r, l, t,
b or same.

A rotation will be performed if this position is
different from the side passed to -register.

-output_peg_matrix
This option outputs the peg transformationmatrix
on standard output.

-scanner_calibrate < (default 1.0000 1.0000) >
This option sets the x and y scale factors to be
applied to scanner image.

FILTERINGOPTIONS

-pixel <pixel_shape (default '4x3')> The valid value is: 4x3.
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COMMAND ACTION

-gap <worldUnits (default 10)>
Use this option to set the size of gaps that will be
automatically closed.

-pencil Use this option to generate line art only.

-keep_dirt Use this option to not filter dirt.

-thresh <threshold (default 0.2)> Use this option to set the threshold value.

-rmv_hairs <worldUnits (default 1)> <passes
(default 1)>

Use this option to remove hair smaller than the
defined size in a specific number of passes.

-rmv_holes <area (default 7)>
Use this option to remove holes smaller than the
defined area size.

-rmv_dirt <area (default 1)>

This option will remove dirt smaller than the
defined size. You can set values in the range of
100 to 500. The size, or area, is in world units
squared.

-rmv_triangles <worldUnits (default 30.000000)>

Use this option to remove triangles at the defined
pixel distance from each other.

You can use -no_break to remove all triangles.

-no_texture
This option prevents textured strokes to be
generated.

-color_as_texture
This option will vectorize the alpha channel and
put the RGB colour in a textured colour.

-noclosegap
This option will prevent gaps from being
automatically closed.

-no_break This option disables the breaking of line art.

-jag_filter <pixels (default 0>

This option will expand the pixels in the
vectorization bitmap to give a jagged line amore
straight and smooth result.

This makes use of the -expand_bitmap option to
expand the line by 1 or 2 pixels and then contract
it by the same amount, removing any jaggedness
from the line in the process.

-expand_bitmap <pixels (default 0>

This option expand the pixels in the vectorization
bitmap.

This is used to thicken the line.

-fit_errorc <error (default 1.000000>

This option defines the fit error for the colour art.

A fit error occurs when there are three points on a
curved or angled line and the systemmisses the
middle point. For example, instead of a the line
going from point 1 up to point 2 and then down to
point 3, to form a curve or angled line, it goes
from point 1 to point 3missing point 2 and
creating a straight line. Using the -fit_error option
eliminates this error.

10



Harmony 14 Utilities Guide

COMMAND ACTION

-fit_errorl <error (default 1.000000>

This option defines the fit error for the line art.

A fit error occurs when there are three points on a
curved or angled line and the systemmisses the
middle point. For example, instead of a the line
going from point 1 up to point 2 and then down to
point 3, to form a curve or angled line, it goes
from point 1 to point 3missing point 2 and
creating a straight line. Using the -fit_error option
eliminates this error.

-smoothl <passes (default 1>
This option defines the number of smooth
passes for the line art.

-smoothc <passes (default 1>
This option defines the number of smooth
passes for the colour art.

-first_smooth <passes (default 0>
This option defines the number of smooth
passes on the line art before breaking triangles.

-first_smoothl <passes (default 0>
This option defines the number of smooth
passes for line art before breaking triangles.

-first_smoothc <passes (default 0>
This option defines the number of smooth
passes to perform. For line art in colour art pass
(needs -2pass).

-2pass

This option specify 2 sets of parameters; one for
line art "l", one for colour art "c"(-thresh, -rmv_
holes and -rmv_dirt will be overridden by -threshl,
-threshc, -rmv_holesl, -rmv_holesc, -rmv_dirtl
and -rmv_dirtc).

-threshl <threshold for line art (default 0.5)>

This option sets the threshold value for the line
art.

Range can be from 0.0 to 1.0.

-threshc <threshold for color art (default 0.5)>

This option sets the threshold value for the colour
art.

Range can be from 0.0 to 1.0.

-jag_filterl <pixels (default 0>
This option expands the pixels in the
vectorization bitmap for line art. To smooth and
straighten jagged lines.

-jag_filterc <pixels (default 0>
This option expands the pixels in the
vectorization bitmap for colour art. To smooth
and straighten jagged lines.

-expand_bitmapl <pixels (default 0>
This option expands the pixels in the
vectorization bitmap for line art.

-expand_bitmapc <pixels (default 0>
This option expands the pixels in the
vectorization bitmap for colour art.

-rmv_holesl <area (default 7)>
This option removes line art holes smaller than
the specified area.
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COMMAND ACTION

-rmv_holesc <area (default 7)>
This option removes colour art holes smaller than
the specified area.

-rmv_dirtl <area (default 1)>

This option will remove dirt on the line art that is
smaller than the defined size.

You can set values in the range of 100 to 500.
The size, or area, is in world units squared.

-rmv_dirtc <area (default 1)>

This option removes dirt on the colour art that is
smaller than the defined size.

You can set values in the range of 100 to 500.
The size, or area, is in world units squared.

-margins <inch (default 0.25)>
This option removes themargin around
bitmap.Youmust define the size of themargin in
inches.

-top_margin <inch (default 0.25)>
This option removes the topmargin of bitmap.
Youmust define the size of themargin in inches.

-bottom_margin <inch (default 0.25)>
This option removes the bottommargin of
bitmap. Youmust define the size of themargin in
inches.

-left_margin <inch (default 0.25)>
This option removes the left margin of bitmap.
Youmust define the size of themargin in inches.

-right_margin <inch (default 0.25)>
This option removes the right margin of bitmap.
Youmust define the size of themargin in inches.

-remove_peg_bars This option removes the registrationmarks.

-field_size <fields (default 12 or use value in scan
file)>

This option sets the drawing to this field size.

-fs

This is the abbreviated version of -field_size
function.

Use this option to set the drawing field size.

-peg_bar_size <inch (default 1)> This option sets the size of the peg bar region.

-noframe
This option prevents a frame being added around
the colour art.

-frame_fields <default -1.000000>
This option will put a frame of the specified
dimension around the colour art.

-downscale_input <default 1> t
This option downscales the raw input by this
integer factor.

-downscale_texture <default 1>
This option downscales the output texture by this
integer factor.

-buildmatte
This option will automatically generate amatte
on the underlay layer for quick line test.

-buildmatte_colourart
This option will automatically generate amatte
on the colour art layer for quick line test.
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COMMAND ACTION

-copystrokes

This option will copy the original strokes when
building thematte.

Note that -buildmatte and -buildmatte_colourart
aremutually exclusive.

Options for bitmap that have no registration
information

-pixel_margins <inch (default 0)>
This option sets the size in inches for the bitmap
margin.

-top_pixel_margin <inch (default 0)>
This option sets the size value in inches for the
bitmap topmargin.

-bottom_pixel_margin <inch (default 0)>
This option sets the size value in inches for the
bitmap bottommargin.

-left_pixel_margin <inch (default 0)>
This option sets the size value in inches for the
bitmap left margin.

-right_pixel_margin <inch (default 0)>
This option sets the size value in inches for the
bitmap right margin.

-dpi <(default -1)>
This option defines the dpi information of input
bitmap.

RGB KEYINGOPTIONS

-rgb
Use this option to generate separate zones for
red green and blue lines.

-rgb_alpha <value (default 255)>
Use this option to set an alpha value for red,
green and blue colours.

-no_red
Use this option to ignore the colour red during
vectorization.

-no_green
Use this option to ignore the colour green during
vectorization.

-no_blue
Use this option to ignore the colour blue during
vectorization.

-flatten
Use this option to perform a flatten on the
drawing after generating the colours.

-rmv_rgb_dirt <threshold area default 0.0>
Use this option to remove red, green and blue
regions smaller than the specified area.

-expand_bitmap_rgb <pixels (default 0>
This option expands the pixels in the
vectorization bitmap for rgb.

-threshrgb <value> <threshold for rgb
vectorization default 0.200000>

This option defines the thresholds on rgb
vectorization and value to consider a pixel to be
gray.

-threshsv <saturation threshold default
0.500000> <value threshold default 0.500000>

This option defines the thresholds on saturation
and value to consider a pixel to be gray.

COLOUR VECTORIZATION OPTIONS Note that the following colour vectorization
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COMMAND ACTION

options are experimental.

-color_vectorize Use this option to perform a colour vectorization.

-file2 <color art filename>
This option specifies the colour art bitmap file to
perform vectorization on.

-penstyle <center alpha (0.0-20.0)> <edge alpha
(0.0-20.0)> <gamma (0-10)> <centre pressure
effect (0.0-1.0)> <edge pressure effect (0.0-
1.0)><texture bitmap downscaling (0.2-20)>
<texture bitmap file (valid filename or "" if no file)>

Use this option to generate and set a brush
texture for the line art.

-pressure_variation <strategy (0, 1 or 2)> <min
pressure (0.0-1.0)> <max pressure (0.0-1.0)>
<max variation (0.0-1.0)>

This option specifies a pressure strategy for the
centre line.

-blur_radius <pixels (default 0)> This option blurs the generated brush texture.

-color_contour_smooth_passes <times (default
3)>

This option sets the performed number of smooth
passed on contour before computing texture.

-ccsp <times (default 3)>

This is the abbreviated version of the -color_
contour_smooth_passes function.

This option sets the performed number of smooth
passed on contour before computing texture.

-color_rmv_holesl <world units (default
0.000000)>

This option sets the size of holes to be removed
when computing texture.

-color_fill_holesl <world units (default 0.000000)>
This option will automatically fill holes of the
selected size on the colour art layer.

BUBBLE USAGE

(implemented only for colour vectorization's line
art)

To learnmore about the Bubble command, refer
to the How to VectorizeWith Bubbles section.

-create_bubbles
This optionmodifies the original line art of a
drawing by randomly inserting bubble shapes in
it.

-bubble_gap <value (default 3)>
This option defines themaximum number of
colour art points between two consecutive
bubbles.

-bubble_length <value (default 10)>
This option defines themaximum number of
different radius circles in a single bubble.

-min_radius <value (default 1.5000)>
This option defines theminimum radius of a
circle in a bubble relative to the line thickness
(must be >= 1.0).

-max_radius <value (default 3.5000)>
This option defines themaximum radius of a
circle in a bubble relative to the line thickness
(must be >= 1.0).

-uniform_gap
This option specifies that the bubbles should be
placed at equal distance from each other.

14



Harmony 14 Utilities Guide

COMMAND ACTION

-uniform_height
This option forces the height of the bubbles to be
the same for all bubbles.

Vectorization

The options that are used during the vectorization process are based on vectorization styles. You can select a
preset from a list, or customize your own.

Some of the commonly used vectorization styles displayed in the Custom Vectorization Parameters, and the Import
Drawings dialog boxes, use parameters similar to the following examples:

• Black andWhite

• Tones/highlights (B+W notriangles)

• Greyscale Rougher Lines

• Greyscale Soft Edge

Black and White

Use this style to vectorize black and white (1-bit) SCAN, or any other black and white files. Black and white 1-bit
files include no texture information.

options: -no_texture -rmv_holes 7 -rmv_dirt 10 -fit_errorl 2.0 -fit_
errorc 2.0

When you vectorize black and white drawings with these options, the vector files will contain no texture (-no_
texture); all lines will be solid.

These options also remove holes, (-rmv_holes 7) and dirt, (-rmv_dirt 10) of specific sizes.

The fit_errorl and fit_errorc options also filter the contours that form ink lines and colour art so that they
are smoother.
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Tones/highlights (B+W notriangles)

This style vectorizes black and white 1-bit files that will be used as mattes to build tone and highlight effects.

options: -no_texture -rmv_holes 7 -rmv_dirt 10 -fit_errorl 2.0 -fit_
errorc 2.0 -no_break

These options prohibit the creation of line textures, remove holes and dirt, and smooth final drawings. These
options also remove triangles (-no_break) at the intersection of lines in the line art.

Triangles are useful at intersections if the intersecting lines are to be painted using different colours. This is
unnecessary in drawings, likemattes, that will be painted a solid colour.

Greyscale rougher lines

This style vectorizes greyscale drawings, maintaining the rough textures in the lines.

options: -2pass -threshl 0.1 -threshc 0.2 -rmv_holesl 7 -rmv_holesc 7
-rmv_dirtl 10 -rmv_dirtc 10 -expand_bitmap 0 -fit_errorc 3.0 -fit_
errorl 3.0 -jag_filterc 1 -rmv_hairs 30 3 -rmv_triangles 90

As you can see in the example below, the drawing gets its character from the roughness of its lines. You would
not want to lose the distinctness of the line during the vectorization process.
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The options in this style force two passes of the vectorization process to apply different values to the line art and
colour art (-2pass). Youmust specify values for the line art and colour art when you use this option.

For drawings with specific vector-style lines or mattes, you only need one pass. For greyscale drawings, youmay
want to pass through the vectorization process twice to apply different values to the line art and colour art.

The colour art (-threshc) and line art (-threshl) thresholds determine what values in the scanned image will be
considered as part of the drawing, and what will be ignored and eliminated in the vectorized drawing. Zero (0) is white
and one (1) is black. The threshold is between these two values.

The expand_bitmap and jag_filter options work together so that you can pick up noise, or small pencil lines
andmarks, during the vectorization process. The expand_bitmap option expands the bitmap to pick up the noise.
When used with jag_filter, the bitmap is shrunk down by the value of the option. You use these two options
together to maintain the size of your line art.

The fit_error options smooth ink lines and colour art strokes.

The rmv_holes and rmv_dirt options remove hair and dirt of a specific size from the line art and colour art. The
rmv_hairs option removes tiny strokes that extend frommain colour art strokes. And, rmv_triangles option
removes triangles and intersections that are less than the specified distance apart.

Greyscale soft edge

Use this vectorize style when you want to create a vector image with fine, textured strokes. Unlike the Grayscale
rougher lines style, this style is meant for more subtle line variations.

style_name: Grayscale soft edge

options: -2pass -threshl 0.05 -threshc 0.05 -rmv_holesl 7 -rmv_holesc 7
-rmv_dirtl 10 -rmv_dirtc 10 -fit_errorl 2.0 -fit_errorc 2.0 -expand_
bitmapl 1

Compare these options to the Grayscale rougher lines style. You will notice that the
-thresh values are smaller; therefore, fewer pixels will be filtered out.This contributes to the fluffier appearance of
the lines. You will also notice that the fit_error value is smaller and the -expand_bitmap value is larger. All of
these options contribute to the smoother appearance of the final line.

How to Vectorize With Bubbles

Vectorizing with bubbles allows the user to modify the original LineArt of a drawing by randomly inserting bubble
shapes.
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The command inserts bubbles starts from the circle with the smallest radius (min_radius), with the centre on one
colour art point. The command then adds subsequent circles on the remaining colour art points, increasing their
radius each time. The command adds new circles in ascending order of radius until the bubbles reach the
maximum size specified by themax_radius parameter.

The command inserts the first and last circle at theminimum radius (specified by themin_radius parameter) and
randomly assigns the height of themiddle circle based on the bubble_length parameter.

For each bubble that appears, the command selects a random number of colour art points to set the distance
between bubbles. The bubble_gap specifies themaximum number of such points, with theminimum being zero.

Examples

Drawing With Uniform Line Thickness

The initial drawing has a uniform thickness. Use it to view and compare the results of the following bubbles
options.

• Example 1
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The drawing has been vectorized using the command options:

-create_bubbles -bubble_gap 3 -bubble_length 16 -max_radius

• Example 2

The drawing has been vectorized using the command options:

-create_bubbles -bubble_gap 3 -bubble_length 4 -max_radius 3.5

• Example 3
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The drawing has been vectorized using the command options:

-create_bubbles -bubble_gap 3 -bubble_length 16 -max_radius 3.5

• Example 4

The drawing has been vectorized using the options:

-create_bubbles -bubble_gap 3 -bubble_length 4 -max_radius 3.0 -
uniform_gap -uniform_height
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Swf2tvg Utility
The Swf2tvg utility is used to import an SWF file into your scene without using the interface. This will create a .tvg
file for each frame. Use the different commands to control the options.

Here is the format youmust follow when using Swf2tvg:

Swf2Tvg -palette <palette_file> -usage -help -use_different_palettes

-base_name <base_out_name> -outdir <output directory> -bbox_recenter

-ignore_position -start_index <number> file1 [file2] [file3]

Here are the available Swf2tvg options:

COMMAND ACTION

DESCRIPTION OF SWITCHES

-palette <palette_file>
This option is used to add the colours of the SWF file to the
palette file and save it.

-use_different_palettes
This option is used to create a new palette for each SWF file
and DOES NOT save any palette.

-base_name <name>
Use this option to automatically rename all generated
drawings name-x.tvg where x is an increasing index.

-start_index <index>

Use this option to define the starting index to name the
drawings.

The default value is 1.

-outdir <dir>
Use this option to define the output directory for all generated
drawings.

-use_place_objects

This option will transform and position the imported drawings
following the position on the stage in the Flash project. This
option uses the information that is contained in the SWF
PLACE_OBJECT record.

Note: this option does not use -start_index.

-frame_alias <list>

This option uses the comma separated list of names to
generate timing information.

This is mainly to convert models.

e.g. -frame_alias FR_%.2d,3Q_%.2d,BK_%.2d"

-base_color_index <index> Use this option to base the colour index in higher 32 bits.

-bbox_recenter
This option centres drawings according to their bounding box.

This option implies -ignore_position.

-ignore_position Use this option to ignore all sceneplanning information.

-usage This option will display the usage.

-?|-h|-help|--help This option will display the help information.

-v|-version|--version This option will display the version information.
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NOTE:
• If -outdir is not specified, the files will be written in the SWF file current directory.

• You can specify any SWF file or PLT file. The PLT files will be read and used tomatch colours but will
not bemodified. The only palette modified is the palette specified by the -palette switch.

Swfimport Utility
The Swfimport utility is used to create a template from a SWF file.

Here is the format youmust follow when using Swfimport:

SwfImport [options] swf_files

Here are the available Swfimport options:

COMMAND ACTION

AVAILABLE OPTIONS

-outdir output_folder
This option specifies the output folder for the generated
templates

-applycolourtransform
This option will apply colour transforms from SWF onto
the drawings.

-paletteName name_of_palette
Use this option to specify the name of the palette file to
use with colour recovery.

DESCRIPTION OF SWITCHES

-outdir dir
This option specifies the output folder for the templates
(The specified folder must already exist.)

-usage This option will display the usage.

-?|-h|-help|--help This option will display the help information.

-v|-version|--version This option will display the version information.

Swfimport does not overwrite templates.

tvg2xml Utility
The tvg2xml utility is used for debugging purposes; it will convert your TVG files to an XML file format that you
can read.

Here is the format youmust follow when using tvg2xml:

tvg2xml -file <filename (including extension)> [ options ]

Here are the available tvg2xml options:

22



Harmony 14 Utilities Guide

COMMAND ACTION

OPTIONS

-infile <filename (including extension)> Use this option to define the file to perform tvg2xml on.

-outfile <filename>
This option is used to define an alternate output file. Use - for
output to standard output.

-discretize [optional scale default = 0.1]

This option discretizes the Bezier path using scale. Scale
typically range from 0.025 to 4. A larger numbermeans a
higher resolution.

NOTE: Discretize is a process where each pixel of an image
is converted into the black foreground or the white
background. The colours and grays of the original image are
lost. By controlling discretizing, unwanted parts of the
original image can be removed. This process of converting
colour images into black foreground and white background is
called discretizing.

-no_bitmap_data
This option will prevent the output of bitmap data. This will
produce a smaller XML files if the bitmap data is not needed.

-flatten This option will perform a flatten on the layers.

-v|-version|--version This option will display the version information.

-?|-h|-help|--help This option will display the help information.

uinfo Utility
The uinfo utility is used to display the following information about a specified bitmap file.

• Name

• Resolution

• Format

• Channels

• Bites per Channels

Here is the format youmust follow when using uinfo:

uinfo program input_files

COMMAND ACTION

AVAILABLE OPTIONS

-?|-h|-help|--help This option will display the help information.

-v|-version|--version This option will display the version information.

utransform Utility
The utransform program converts vector images to pixmaps, and between different pixmap file formats. For
example, you can use utransform to convert a TGA to an SGI file. Or, you can convert a TVG file to a Photoshop
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PSD file.

Here is the format youmust follow when using utransform:

utransform -outformat [options] [file name, including extension]

Here are the available utransform options:

COMMAND ACTION

OPTIONS

-outformat <format>

This is the file type you want to output with utransform.

The following are the file formats supported by utransform:
TGA, TGA1, TGA3, TGA4, SGI, SGI1, SGI3, SGI4,
SGIDP3, SGIDP4, OMFJPEG, OPT, OPT1, OPT3,
OPT4, PSD, PSD1, PSD3, PSD4, PSDDP3, PSDDP4,
YUV, PAL, and SCAN.

-outfile <name>

This option is for the file name of the output file.

If you are processingmultiple files, you will not be able to
control their final name. If not specified, the files created
by utransform will have the same file name as the original.
The only difference will be the file extension.

-crop

Outputs part of a tvg where the lines are. A bitmap of the
bounding box around those lines is output as well as an
XML file with the position of that bitmap in relation to the
Camera view.

-debug
This option will display information on the different steps
of the process as well as themessages related to errors
that might have occurred.

-?|-h|-help|--help This option will display the help information.

-v|-version|--version This option will display the version information.

IMAGE OPTIONS

-resolution <w> <h>
This optionmanages vector and pixmap input files. It
indicates the height and width of the output file.

-resolution scan
This option will use the.scan info to determine the drawing
resolution when unvectorizing from the Control Centre.

-scale <s>

Use this option to scale the height and the width of the
output file by the value you enter.

The resolution of the imagemust be able to accommodate
the new image size.

-xscale <s>

Use this option to scale the width of the output file.

The resolution of the imagemust be able to accommodate
the new image size.

-yscale <s>
Use this option to scale the height of the output file.

The resolution of the imagemust be able to accommodate
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COMMAND ACTION

the new image size.

-turn <degrees>
Use this option to rotate the output file by the amount of
degree entered.

-ps <in> <out>

Use this option to convert the shape of the pixel.

This option inputs and outputs pixel shapes for formats
other than YUV and PAL.

The possible values are: square, NTSC and PAL.

-bgcolor <r> <g> <b>

This option defines the background colour for TVG
images.

The range is either 0-1 (a percentage of 255) or 0 - 255.
The default value is white.

-bgalpha <a>

This is the alpha value of the background.

The range is either 0-1 or 0 - 255. The default value is
opaque (255).

VECTOR OPTIONS

-antialiasing <quality><exponent>

quality = low, medium-low, medium or high exponent =
between 0-3

This option is for converting vector images to pixmaps.

You can specify the quality of the anti-aliasing process
(low, medium-low, medium or high) or the exponent
(between 0-3).

-nolinetexture
This disables the generation of line textures from TVG
files.

-nolineart Use this option to exclude line art from the output file.

-nocolorart Use this option to exclude colour art from output file.

-move <x> <y>

Use this option to recentre the output file, output pixels or
world units for TVG output

Note: Useful values for TVG output might be
714.285000 in x or 535.713750 in y

-flatten

Use this option to flatten the drawing andmerge its
textures.

By default the output file format is TVG.

-bboxtvgincrease
This option will increase the .tvg bonding box size. The
default value is 5 (percent).

-normalize

This option normalizes the TVG. This implies that the
outformat is TVG.

If the TVG has a different scaling than 1, it will scale the
coordinates and set the scaling to 1.0.

-setfieldsize <f> Use this option to set the internal scaling of the TVG to an
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COMMAND ACTION

exact field size.

VECTOR TOVECTOR OPTIONS

-centreline
Use this option to extract the centreline of the drawing’s
line art.

-closegap Use this option to perform Close gap.

-gaplength
Use this option to define a Close gap length value.

The default value is 10.

-hairpasses
Use this option to set the number of pass to perform for
the remove hair option. The default value is 2.

-hairlength
Use this option to define the value for the hair length. The
default is 20.

-keepcolorart
Use this option to keep the existing colour art and extract
the centreline over it.

-showstrokes
Use this option to show the contour of line art and
centrelines in special colours.

-thickness
Use this option to define the thickness in pixels of the
strokes to show.

-fieldsize <fs>
Use this option to set the field size for PDF output.

The default field size is 12.

-lineartstrokescolor <r> <g> <b> <a>
Use this option to define the red, green, blue, alpha values
for the line art stroke colour.

-colorartstrokescolor <r> <g> <b> <a>
Use this option to define the red, green, blue, alpha values
for the colour art stroke colour.

-nofitcolorart
Use this option if you do NOT want to generate Bezier
curves for colour art.

-tvgversion [version]

This option will convert to older/supported vector format
product version:

v720 = 1005

v710 = 1005

v702 = 1004 (Early version of 7.0.2 were using1003.)

v700 = 1003

ALIGNMENT OPTIONS

-align <RULE>

Use this option to generate a bitmap that will fit inside
Harmony with a read node aligned with a defined rule.

RULE can be: AS_IS, CENTER_TB, CENTER_LR,
CENTER_FIRST_PAGE_HORIZONTAL, CENTER_
FIRST_PAGE_VERTICAL, TOP, BOTTOM, LEFT,
RIGHT.
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COMMAND ACTION

-dpi <dpi>

Use this option to define the output resolution for the
bitmap image in dots per inch.

The default resolution is 75 dpi.

-sar <scene_aspect_ratio>

This option sets the scene aspect ratio, the default is
1.33333. Use 1.7777777 for 16/9 scenes. The scene
aspect ratio can be read from the scene alignment dialog.
Beware, that this is not the ratio of the scene resolution.

Output a Layout to a Bitmap Format

Once your backgrounds are done in a Toon Boom application, you are ready to paint them. You can paint your
backgrounds within the software, or export them to a third-party bitmap software to paint.

There are two techniques for exporting vector black and white backgrounds:

• Render Network

• utransform and Exporting a Panoramic Background

Render Network

To export your background image, you can add aWrite node to your network and use the RenderWrite Node option
to export the framewhere your background is. The background image will be exported and cropped to the scene
resolution.

If you have a panoramic background, use the utransform utility to export your image.

NOTE: Refer to the Toon Boom Harmony User Guide to learn how to render your background from your net-
work.
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utransform and Exporting a Panoramic Background

The utransform utility is able to do some format conversions and limited image processing.

By default, the utransform utility will convert the strokes and colour zones that are within the 12 field chart. If you
have extra artwork outside of the 12 field, you will have to scale down the drawing using the utransform utility in
order to fit it in the 12 field zone, and enlarge the bitmap export resolution.

The panoramic background export will work with the alignment rule of your background drawing in your Toon
Boom software.

There are several alignment rules to consider:

• Centre Top and Bottom

• Centre Left and Right

• Centre First Page Horizontal

• Centre First Page Vertical

• Left

• Right

• Top

• Bottom

Centre Top and Bottom

The Centre Top and Bottom rule is used for a vertical pan background where the default scene’s 12 field is placed
at the centre of the drawing.

Centre Left and Right

The Centre Left and Right rule is used for a horizontal pan background where the default scene’s 12 field is
placed at the centre of the drawing.
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Centre First Page Horizontal

The Centre First Page Horizontal rule is used for a horizontal pan background where the default scene’s 12 field is
placed at the far left of the drawing.

Centre First Page Vertical

The Centre First Page Vertical rule is used for a vertical pan background where the default scene’s 12 field is placed
at the very bottom of the drawing.

Left

The Left rule is the default alignment for drawings. It aligns the drawings with the left side of the scene’s alignment
rectangle. Harmony scales the drawings tomatch their heights to the alignment rectangle of the scene.

Right

The Right rule aligns the drawings with the right side of the alignment rectangle. Harmony scales the drawings to
match their heights to the alignment rectangle of the scene.
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Top

The Top rule aligns with drawings with the top of the alignment rectangle. Toon Boom Animate scales the
drawings tomatch their widths to the width of the alignment rectangle of the scene.

Bottom

The Bottom rule aligns the drawings with the bottom of the alignment rectangle. Toon Boom Animate scales the
drawings tomatch the drawings' width to the width of the alignment rectangle of the scene.

As Is

The As Is alignment rule is used when you have artwork outside every edge of the 12 field size, such as a Safety
Paint edge.

To properly export your background and re-import it so that it fits precisely into your scene, you have to provide
utransform with the exact resolution that you want the file to be, since you are passing from a vector based image
to a bitmap image.

There are a few rules that will help you understand the calculation that youmust perform:

• 1 field width equals one inch.

• A 12 field chart has a twelve inch width.

• If you scale your drawing down to fit in the 12 field, you will have to enlarge the output resolution so that the
final image has the same size as the original drawing (which is not problematic since the source is vector-
based).

• When you re-import your painted background, the bitmap file will be fitted in the 12 field size. You will have
increased the field size so that it fits the original image size.

To find the scale and DPI that you will need to export your image, you will need the following information:

• The field size of the drawing.

• The scene resolution.
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NOTE: Note that this process will work with a 12x12 scene alignment and when using Harmony.

To export a .tvg file to bitmap using the As Is alignment:

1. In the Timeline or Xsheet view, select the cell that contains the drawing that you want to export.

2. In the Tools toolbar, choose the Select tool. The default keyboard shortcut is [Alt]+[V].

3. In the Drawing view, select all of your drawing strokes. Select Edit > Select All. TheCtrl + A (Win-
dows/Linux) or⌘ + A (Mac OS X).

4. In the Drawing view, place your mouse cursor over the top, right corner.

5. From the Drawing view’s bottom toolbar, note the X and Y field chart information.
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6. Repeat steps 4 and 5 for the bottom, left corner.

7. Once you have all of your field information, select the greatest X and Y values. These will give you the
total field size of your drawing. This also tells you the width of your drawing, in inches (1 field width is equal
to one inch).

8. Divide the X and Y field values by 12 to know how much to scale the image to fit it in the 12 field.

X/12 = how much bigger your drawing is than the 12 field

Y/12 = How much bigger your drawing is than the 12 field

9. Once you have both scaling values, calculate your official scaling value by dividing 1 by the greater of the
two values. This will give you the official scaling value to enter into your utransform command line.

1/(X/12) or 1/(Y/12) = Scaling Value
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10. To enlarge the output resolution, you will have to give a precise amount of DPI. In this case, divide your
scene resolution width (Rx) by 12 (fields) to know how many pixels per inch you have.

Rx/12 = Pixels per inch.

11. Once you have your scene’s DPI, you need to enlarge it to re-scale your output to the correct size, since we
scaled down the drawing strokes. To do so, multiply the scene’s DPI by how much larger the drawing is than
the 12 field (X/12) or (Y/12).

(Rx/12) x (X/12) or (Y/12) = Amount of DPI needed for the drawing output

12. Once the values are calculated, open the command prompt to launch utransform.

13. In the Command Prompt, go to the scene’s element directory that contains the *.tvg drawing that you want to
convert.
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‣ Use the cd command to go back up one directory.

‣ Use the cd \directory name command to enter a new directory.

‣ Use the dir command to see the directories available.

14. Once in your scene’s element directory, type:

‣ ForWindows/Linux: utransform -outformat file_format_you_need -scale scale_
value -dpi dpi_value -bgalpha 0 file_name.tvg

‣ For Mac OS X: ./utransform -outformat file_format_you_need -scale scale_value
-dpi dpi_value -bgalpha 0 file_name.tvg

Here is an example of what your command line should look like:

‣ ForWindows/Linux: utransform -outformat PNG4 -scale 0.75 -dpi 227.55 -
bgalpha 0 bg-1.tvg

‣ For Mac OS X: ./utransform -outformat PNG4 -scale 0.75 -dpi 227.55 -bgalpha
0 bg-1.tvg

15. In the operating system, browse to the scene’s element folder and open the new bitmap file to paint in
third-party software.

To import a utransform bitmap background back in Toon Boom Harmony:

1. Open the Toon Boom Harmony scene where the background needs to be imported.

2. To import a bitmap:

‣ In the topmenu, select File > Import > Images.

The Import Drawings dialog box opens.
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3. Click on the Browse button and select your bitmap background file.

4. Click on the Open button.

5. You can import the image into an existing element or create a new element.

‣ To import the image into an existing layer, select Add to Existing Layer and select the appropriate
element from the list.

‣ To import the image into a new element, select

Create Layer(s) > Create Single Layer Named and type a name for the element in the Name field.

6. Disable the Vectorize Imported Items option.

7. Click on the OK button.

8. Open the background’s layer properties:

‣ In the Timeline view, double-click on the background’s node.

‣ In the Network view, click on the background node’s yellow square.

The Layer Properties dialog box opens.

9. In the Advanced tab, set the alignment rule to As Is.
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10. Click on the OK button.

11. Open the column editor:

‣ In the Timeline view, select the background’s layer, right-click and select Column Properties.

‣ In the Xsheet view, double-click on the background column’s header

12. Take your previous (X/12) or (Y/12) value andmultiply it by the scene’s field to find the correct field size.
Enter this into the Field Chart field.

‣ (X/12) or (Y/12) x Scene’s field

‣ To see the Field Chart field, youmust enable the Advanced Element Mode preference found in the
Advanced section of the Preferences panel.

Here is an example of what it should look like: 1.5 x 12 = 18

13. Click on the OK button.
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ConsolidateDb Utility
The ConsolidateDb command line utility allows you to reduce the amount of drawings in your scene by merging the
elements that have the same drawings together.

ConsolidateDb works by going through the target scene's elements to detect any pair of elements that contain the
same drawings, which typically occurs when importing a template several times or when duplicating layers. If it
finds two elements that have the same drawings, it will merge both elements together into a single element.

Merging elements is done by keeping the original element, deleting the drawings in the duplicate element, and linking
the column that was originally linked to the duplicate element to the original element. If the duplicate element has
any extra drawings that are not in the original element, those drawings aremoved to the original element so that they
do not get removed from the scene.

By default, ConsolidateDb will not merge two elements that appear to match if they have at least one drawing with
the same name, but different artwork, as it would require renaming one of the drawings to keep both of them in the
same element. With the -renameTiming option, ConsolidateDb will merge e#lements even if it has to rename
some drawings to keep all of the drawings in both elements. It will also update the Xsheet columns with the new
names of the renamed drawings to avoid affecting the rendered image.

NOTE:
l This utility only works on one scene at a time. Shell scripts must be used to run ConsolidateDb on an
entire job, environment or database.

l ConsolidateDb can also be used on Harmony Stand Alone scenes.

IMPORTANT:
l It is possible to add palettes to individual elements, whichmakes it possible to make two elements with
the same drawings use different colours. If two elements have the same drawings but have different
palettes, ConsolidateDb will merge them together regardless, which will cause them to use the same
palette andmay affect the colours of themerged element in the rendered image.

l ConsolidateDb will delete files permanently from the target scene. Although it is designed to avoid affect-
ing the rendered image and to only remove files that are unnecessary, it is highly recommended tomake
a backup of a scene before running ConsolidateDb on it.

Syntax
When using Harmony Server:

ConsolidateDb [options] -env <environment> -job <job> -scene <scene> -
user <username>

When using Harmony Stand Alone:

ConsolidateDb [options] <path to scene folder>
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Examples
ConsolidateDb -renameTiming -removeEmptyElements -env myProject -job
S03E05 -scene SC0015 -user jdoe

ConsolidateDb -verbose 2 C:\Users\jdoe\Documents\MyScene

Parameters
Parameter Description

Database Scene Location

-env <environment> The environment in which the target scene is located.

-job <job> The job in which the target scene is located.

-scene <scene> The name of the target scene.

-user <username> The Harmony user who will perform the consolidation.

Consolidation Options

-renameTiming

By default, ConsolidateDb will not merge two elements if
they contain drawings with the same name, but not the
same artwork. With this option enabled, ConsolidateDb
will merge elements as long as they have at least one
drawing in common.

When two drawings have the same name but not the same
artwork, one of the drawings is renamed before it is moved
to themerged element. This allows ConsolidateDb to keep
all the drawings in the both elements without causing any
naming conflict.

The Xsheet columns will be updated to preserve the
exposure of drawings getting renamed. Hence, the
rendered image will not be affected.

-removeEmptyElements

By default, ConsolidateDb leaves the empty element
folder behind after it has deleted all the drawings in a duplic-
ate element. With this parameter, ConsolidateDb will
delete an element after it emptied it.

-verbose 1

-verbose 2

Increases the amount of information reported to the
terminal while the scene is being consolidated.

Verbosemode 1 will output the following information:

l The origin of each drawing in duplicate elements
followed by their destination in the original element.

l Each drawing file it deletes.

Verbosemode 2 will output the following information:

l The origin and destination of each drawing in both
the original element and its duplicate elements.

l Each drawing it removes from or adds to each
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Parameter Description

column.

l Each drawing files it deletes.

Miscellaneous

-?

-h

-help

--help

Displays the usage information in the terminal.

-v

-version

--version

Displays the version information in the terminal.
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